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1 Open Acrobat Reader DC on your PC or Mac. Adobe Acrobat Reader DC makes it easy to print multiple-page PDF files as booklets using Windows or macOS. If you're using Windows, you'll usually find it in the Start menu. If you're using a Mac, you'll usually find Acrobat Reader DC in the Applications folder. 2 Open the booklet file. Here's how:[1]
Click the File menu at the top-left corner of the screen. Click Open. Open the folder containing the file you want to print. Select the file and click Open. Advertisement 3 Click the File menu. It's at the top-left corner.[2] 4 Click Print. This opens Print dialog screen.[3] 5 Select your printer from the "Printer" menu.[4] 6 Select which pages to print. To
print the entire document, leave All selected under "Pages to Print." To specify a page range, select Pages, then enter the range. Here are some examples of ways you can enter pages to print:[5] To print pages 2 through 10, you'd enter 2-10 into the "Pages" blank. To print pages 1, 4, 9, and 14, you'd type 1, 4, 9, 14 into the "Pages" blank. If you'd
need to print multiple page ranges (e.g., 2 through 12 and 43 through 52), you should print each range separately.[6] 7 Click Booklet. It's under the "Page Sizing & Handling" header. A preview of the document in booklet format will appear on the right side of the panel.[7] 8 Select a duplex option from the "Booklet subset" menu. The option you select
depends on how your printer handles printing on both sides of the page:[8] If your printer automatically prints on both the front and back sides of a sheet without you having to flip the page manually (automatic duplex printing), select Both sides. If you have to manually flip pages to print on both sides, select Front side only for now. After printing the
pages that appear on the front side of each sheet, you'll flip the sheets, re-open this window, and select Back side only before printing again. 9 Select an option from the "Binding" menu. The default option is Left, which prints the booklet like a book (folded on the left side) for left-to-right text.[9] If you want to fold the booklet on the long side of the
page, select Left (Tall). If you're printing in a language that reads right-to-left, select Right or Right (Tall) (if you want to fold the booklet on the long side of the page). 10 Set additional printing preferences (optional). Printers vary in capabilities, but you can typically click Properties next to the printer's name to choose additional settings, such as
whether you want to conserve ink, print in color, or specify printing margins. Some printers will automatically fold and staple your booklets if you choose the right settings. Check your printer's instruction manual. 11 Check the printing preview before you print. Use the arrow buttons below the print preview to page through the document. If you need
to make any changes to the layout, make those changes before you continue.[10] 12 Click Print to print your booklet. If you have an automatic-duplex printer, the pages will print on both sides of each sheet automatically. If you had to print the front-side only, re-insert the printed pages in accordance with your printer's instructions, return to File ->
Print, select Booklet, and then chose Back side only from the "Booklet subset" menu. 13 Fold your finished booklet. If your printer did not fold your booklet automatically, fold it along the desired spine (right or left). You can also staple the booklet to keep the pages intact. Advertisement 1 Open Microsoft Word. You can use Microsoft Word to print any
multiple-page DOC or DOCX document as a booklet. You'll usually find Word in a folder called Microsoft Office in the Start menu. 2 Open the document you want to print. Here's how:[11] Click the File menu at the top-left corner. Click Open. Navigate to the folder that contains the file you want to print. Select the document and click Open. 3 Click the
PAGE LAYOUT tab. It's at the top of most versions of Word.[12] 4 Click the icon at the bottom-right corner of the "Page Setup" panel. This panel is in the bar that runs along the top of Word. The icon is a tiny square with a diagonal arrow. Clicking this button will open the "Page Setup" dialog box.[13] 5 Select Book fold from the "Multiple pages"
menu. It's under the "Pages" header near the center of the dialog box.[14] This changes the orientation to landscape. 6 Adjust your margins and gutter size. These options are under the "Margins" header near the top of the dialog box. The default margins of 1" should work for most peoples' needs, but you may want to increase the "Gutter" value to a
value higher than 1 cm (the default). This gives you more space around the binded/folded part of the booklet.[15] 2 cm should be fine. 7 Click the Paper tab. It's at the top of the dialog box. 8 Choose the correct paper size for your printer. This is usually 8.5" x 11" (Letter) in the US, or A4 in Europe. If you're using a different paper size, select that size
instead. 9 Click OK. This saves your document in a format that will print like a booklet. 10 Click the File menu. It's at the top-left corner. 11 Click Print. This opens the Print dialog. 12 Select your printer from the "Printer" menu. Be sure to select a printer that supports printing on both sides of a single page (either automatic or manual duplex). 13
Select a Print on Both Sides option under "Settings." The option you choose depends on your printer and your booklet.[16] If your printer automatically prints on both the front and back sides of a sheet without you having to flip the page manually (automatic duplex printing), select Print on Both Sides (Flip pages on long edge) to print in a standard
book-like format, or Print on Both Sides (Flip pages on short edge) to flip each page along the shorter side of the page. If you have to manually flip pages to print on both sides, select Manually Print on Both Sides. You'll need to manually reload the pages when prompted by your printer to print on the other side.[17] 14 Set additional printing
preferences (optional). Printers vary in capabilities, but you can typically click Printer Properties below the printer's name to choose additional settings, such as whether you want to conserve ink, print in color, or specify printing margins. Some printers will automatically fold and staple your booklets if you choose the right settings. Check your
printer's instruction manual. 15 Check the printing preview before you print. Use the arrow buttons below the print preview to page through the document. If you need to make any changes to the layout, make those changes before you continue. 16 Click Print to print your booklet. If you have an automatic-duplex printer, the pages will print on both
sides of each sheet automatically. If not, follow the instructions on the printer's panel to reinsert the pages. 17 Fold your finished booklet. If your printer did not fold your booklet automatically, fold it along the desired spine (right or left). You can also staple the booklet to keep the pages intact. Advertisement 1 Open Word. You can use Microsoft
Word to print any multiple-page DOC or DOCX document as a booklet. You'll usually find Word in a folder called Microsoft Office in the Applications folder. To print a booklet properly, you'll need a printer that is capable of printing on both sides of a single page. 2 Click the File menu. It's at the top-left corner of the screen. 3 Click New from Template.
A list of templates will appear. 4 Type booklet into the search bar. The search bar is at the top-right corner of the window. This filters the template results to show only booklet templates, which are already formatted to print in the correct booklet page sequence and orientation.[18] You'll be able to type or paste your own content into any booklet
template. 5 Double-click the template you want to use. There are several to choose from, and all are customizable. 6 Insert your own content into the booklet. The look of your booklet is up to you, but you'll typically want to replace most, if not all, of the text and logos from the template with your own content. To insert an image, click the Insert tab,
select Pictures, and then Pictures from File. Select the photo you want to import, then drag it to the desired location in the booklet. Remove any placeholder text on the template and replace it with your own. To remove any visual element or text from the booklet, select the item (or highlight the text), then press Del. Don't forget to save your work as
you make changes. 7 Click File when you're ready to print. It's at the top-left corner.[19] 8 Click Print. A preview of your booklet will appear, as will some settings you can modify. If you don't see the preview, select Copies & Pages from the third drop-down menu, then check the box next to "Show Quick Preview" at the bottom.[20] Use the arrows
below the preview to see what each printed page will look like. 9 Select your printer from the "Printer" menu. It's at the top of the window. 10 Enter the number of booklets you want to print. It's a good idea to start with 1 to make sure it looks the way you'd like. Type this value into the "Copies" field. If you print more than one booklet, check the box
next to "Collate" so that the Word prints one booklet at a time (rather than multiple copies of the first sheet, then the second sheet, etc.). 11 Select other options for your printer. Printers vary in capabilities, but you can typically use the menus at the top of the window to customize the print, such as whether you want to conserve ink, print in color, or
specify margins.[21] 12 Click Print to print your booklet. If you have an automatic-duplex printer, the pages will print on both sides of each sheet automatically. If not, follow the instructions on the printer's panel to reinsert the pages. 13 Fold your finished booklet. If your printer did not fold your booklet automatically, fold it along the desired spine
(right or left). You can also staple the booklet to keep the pages intact. Advertisement Ask a Question Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Nicole Levine, MFA. Nicole Levine is a Technology Writer and Editor for wikiHow. She has more than 20 years of experience creating
technical documentation and leading support teams at major web hosting and software companies. Nicole also holds an MFA in Creative Writing from Portland State University and teaches composition, fiction-writing, and zine-making at various institutions. This article has been viewed 202,996 times. Co-authors: 13 Updated: February 24, 2025
Views: 202,996 Categories: Making Books Print Send fan mail to authors Thanks to all authors for creating a page that has been read 202,996 times. Are you searching for methods about "how to print a PDF in the form of a booklet?” This technique of printing a PDF as a booklet is an effective and economical way to produce a sleek and polished
booklet from a regular PDF file. However, it can be a bit of a daunting task, especially if you're not familiar with the software or tools needed to accomplish the task. Fortunately, there're several free methods available to help you print your PDF document as a booklet without breaking the bank. Following these methods, you can easily create PDF
booklets (the same format as an electronic book or e-book) without spending a fortune. So let's get started to know "How to Print a PDF as a Booklet?" in a few clicks. How to Print a PDF as a Booklet Using WPS Office WPS Office is a free office suite that offers a range of tools to create, edit, and view documents, presentations, and spreadsheets. It’s
available for Windows, Linux, Android, and iOS platforms. Printing a PDF as a booklet using WPS Office is relatively straightforward. Here are the steps to follow: Open the PDF file you want to print as a booklet in WPS Writer. Click on the "Menu" and select "Print" or click "Ctrl+P" to open printer settings. In the print settings dialog box, select your
printer and click on the "Properties" button. In the printer properties dialog box, look for an option that says "Layout." Click on it. Now, Look for an option that says "Booklet" and select it. If necessary, choose the orientation and paper size for your booklet.To close the printer properties dialog box, click on "OK". After that, in the print settings dialog
box, opt for "Short side flip" under the "Use double-sided Printing" option. Click "Print" to start printing your booklet. WPS Office will automatically rearrange the pages of your PDF file to fit into a booklet format, with two pages printed on each side of the paper. How to Print a PDF as a Booklet Using Adobe Acrobat DC Adobe Acrobat DC is a popular
PDF reader and editor offering advanced printing options, including booklet printing.Adobe Acrobat DC offers many customization options to print a PDF as a booklet, such as specifying the number of pages per sheet or adding a cover page. Here are the steps to print a PDF as a booklet using Adobe Acrobat DC: Open your PDF file in Adobe Acrobat
DC. Click "File" in the top menu and select "Print." In the Print dialog box, select your printer and click on the "Properties" button. In the Properties dialog box, find the "Page Sizing & Handling" option and select "Booklet" from the drop-down menu. Choose the orientation, either "Landscape" or "Portrait," based on your preference, and click on "OK."
In the Print dialog box, make sure the "Print on Both Sides" option is selected, and choose "Flip on Short Edge" or "Flip on Long Edge," depending on the layout of your document. Under "Pages to Print," choose "All" if you want to print the entire document as a booklet, or select "Pages" and enter the page range if you only want to print a specific
section. Click on "Print" to start printing your PDF as a booklet. How to Print a PDF as a Booklet With PDFelement for Mac PDFelement is a comprehensive PDF editor and reader for Mac that also offers advanced printing options, including booklet printing. Here are the steps to print a PDF as a booklet using PDFelement for Mac: Open the PDF file
in PDFelement for Mac. Click on "File" in the top menu and select "Print." In the Print dialog box, select your printer and click on the "Layout" button. In the Layout dialog box, select the "Two-Sided" option and choose "Booklet" from the drop-down menu. Choose the orientation, either "Landscape" or "Portrait," based on your preference. Under
"Sheets per Booklet," select the number of pages you want to include on each booklet sheet. If you want to add a cover page, select the "Cover Page" option and choose the source of the cover page. Under "Subset," choose to print all pages or a specific page range. Click on "Print" to start printing your PDF as a booklet. Using Tips Always choose the
appropriate paper size (letter size or A4) to create a booklet. Ensure that the page orientation is up to the mark. Ajdust the page margins for binding if you go for hard printing of the booklet. FAQs 1 - Is the WPS office's Print to Booklet feature freely available? Yes, printing a PDF as a booklet is a free feature of the WPS office. 2 - Can I print a PDF as
a booklet on both sides of the paper? Yes, you can print a PDF as a booklet on both sides of the paper. This is known as duplex printing. Download WPS Office For Free to Print a PDF as a Booklet This article has comprehensively touched on “how to print a PDF as a booklet” through powerful tools and simple steps. Of all these, printing PDF as a
booklet with WPS Office software is the most straightforward way. WPS office software can assist in that matter but also facilitates dealing with a variety of file types, i.e., spreadsheet, presentation, PDFs, Docx, etc. Just Download it and see how useful this software suit can be. Aug 6th, 2022 01. Upload a document from your computer or cloud
storage. 02. Add text, images, drawings, shapes, and more. 03. Sign your document online in a few clicks. 04. Send, export, fax, download, or print out your document. Even though PDF continues to be the most common file type, other file formats can be tough to process. Gain access to easy and versatile online capabilities that help you create your
documents completely from scratch, modify them, and change PDF to Booklet. Completely transform how you approach your document workflows no matter of their intricacy. The way to change PDF to Booklet Visit the DocHub website and easily access your account or register a new one. Upload the document file you intend to convertchange from
your device, url, or one of the built-in cloud storage services. Start editing or completing your form using DocHub tools. When ready, just click Done and change PDF to Booklet. Preserve documents within your DocHub account or to your device. Transform your document quality and reclaim working hours with sophisticated document managing
features. Try out DocHub and streamline your workflows in several click-throughs. Check out all file management tools with a free trial version. Seamless PDF editing Editing a PDF is as simple as working in a Word document. You can add text, drawings, highlights, and redact or annotate your document without affecting its quality. No rasterized text
or removed fields. Use an online PDF editor to get your perfect document in minutes. Smooth teamwork Collaborate on documents with your team using a desktop or mobile device. Let others view, edit, comment on, and sign your documents online. You can also make your form public and share its URL anywhere. Automatic saving Every change you
make in a document is automatically saved to the cloud and synchronized across all devices in real-time. No need to send new versions of a document or worry about losing information. Google integrations DocHub integrates with Google Workspace so you can import, edit, and sign your documents directly from your Gmail, Google Drive, and
Dropbox. When finished, export documents to Google Drive or import your Google Address Book and share the document with your contacts. Powerful PDF tools on your mobile device Keep your work flowing even when you're away from your computer. DocHub works on mobile just as easily as it does on desktop. Edit, annotate, and sign documents
from the convenience of your smartphone or tablet. No need to install the app. Secure document sharing and storage Instantly share, email, and fax documents in a secure and compliant way. Set a password, place your documents in encrypted folders, and enable recipient authentication to control who accesses your documents. When completed,
keep your documents secure in the cloud. Access documents and edit, sign, and share them straight from your favorite Google Apps. Install now The tutorial shows how to convert a PDF to a booklet using DocHub Pro DC. Open the PDF file, select "File," then "Print." Choose "DocHub" as the printer and select all pages. Choose "Booklet" from the size
option, adjust font size, spacing, and binding. Choose the orientation and preview pages. Save the file and print it. Subscribe, like, share, and comment on the video. Here are some common questions from our customers that may provide you with the answer you need. If you can’t find the answer to your pdf to booklet converter-related question,
please don’t hesitate to rich out to us. Contact us Convert PDF to booklet online in 3 easy steps Upload your PDF. Its easy to create your online booklet with Flipsnack. Customize your booklet. Make the necessary adjustments, and add interactive elements such as images, shapes, links, videos, and more to enhance your booklet. Publish and share
your booklet. How to make a PDF flipbook Upload the PDF you want to convert to flipbook. Simply drag-and-drop the PDF file on Flipsnack. Customize and brand the appearance of your publication. Publish your online flipbook as public or private. Share your digital publication on any platform. Create a booklet or book Go to Layout Margins Custom
Margins. Change the setting for Multiple pages to Book fold. To reserve space on the inside fold for binding, increase the width of the Gutter. You can add many embellishments to your booklets appearance. Select OK. FlipbookPDF.net is the best service that allows you to turn your PDF into Online FlipBook in just one click, without registration and
without any request for advance payment. Print a multi-page document as booklet: Choose File Print. Select a printer from the menu at the top of the Print dialog box. In the Pages to Print area, select which pages you want in the booklet. Under Page Sizing Handling, choose Booklet. Reader and Acrobat X Choose File Print. Select a printer from the
menu at the top of the Print dialog box. In the Pages to Print area, select which pages you want in the booklet. Under Page Sizing Handling, choose Booklet. Convert PDF to booklet online in 3 easy steps Upload your PDF. Its easy to create your online booklet with Flipsnack. Customize your booklet. Make the necessary adjustments, and add
interactive elements such as images, shapes, links, videos, and more to enhance your booklet. Publish and share your booklet. Printing a Booklet on a Non-Duplex Printer: (Ctrl + P or the icon.) - Once there, adjust the Name field to docHub PDF. Adjust Page Scaling to Booklet Printing and adjust Booklet Subset to Both Sides. - At this point docHub
will prompt you to save the file. Great solution for PDF docs with very little pre-knowledge required. "Simplicity, familiarity with the menu and user-friendly. It's easy to navigate, make changes and edit whatever you may need. Because it's used alongside Google, the document is always saved, so you don't have to worry about it." A Valuable
Document Signer for Small Businesses. "I love that DocHub is incredibly affordable and customizable. It truly does everything I need it to do, without a large price tag like some of its more well known competitors. I am able to send secure documents directly to me clients emails and via in real time when they are viewing and making alterations to a
document." I can create refillable copies for the templates that I select and then I can publish those. "I like to work and organize my work in the appropriate way to meet and even exceed the demands that are made daily in the office, so I enjoy working with PDF files, I think they are more professional and versatile, they allow..." be ready to get more
Get started now Easily change pdf to booklet online without Easily change pdf to booklet online free convert pdf to printable booklet online pdf to printable booklet online free convert pdf to booklet convert pdf to booklet printing booklet creator online free pdf booklet creator © 2025 DocHub, LLC 1 Open Acrobat Reader DC on your PC or Mac. Adobe
Acrobat Reader DC makes it easy to print multiple-page PDF files as booklets using Windows or macOS. If you're using Windows, you'll usually find it in the Start menu. If you're using a Mac, you'll usually find Acrobat Reader DC in the Applications folder. 2 Open the booklet file. Here's how:[1] Click the File menu at the top-left corner of the screen.
Click Open. Open the folder containing the file you want to print. Select the file and click Open. Advertisement 3 Click the File menu. It's at the top-left corner.[2] 4 Click Print. This opens Print dialog screen.[3] 5 Select your printer from the "Printer" menu.[4] 6 Select which pages to print. To print the entire document, leave All selected under "Pages
to Print." To specify a page range, select Pages, then enter the range. Here are some examples of ways you can enter pages to print:[5] To print pages 2 through 10, you'd enter 2-10 into the "Pages" blank. To print pages 1, 4, 9, and 14, you'd type 1, 4, 9, 14 into the "Pages" blank. If you'd need to print multiple page ranges (e.g., 2 through 12 and 43
through 52), you should print each range separately.[6] 7 Click Booklet. It's under the "Page Sizing & Handling" header. A preview of the document in booklet format will appear on the right side of the panel.[7] 8 Select a duplex option from the "Booklet subset" menu. The option you select depends on how your printer handles printing on both sides
of the page:[8] If your printer automatically prints on both the front and back sides of a sheet without you having to flip the page manually (automatic duplex printing), select Both sides. If you have to manually flip pages to print on both sides, select Front side only for now. After printing the pages that appear on the front side of each sheet, you'll flip
the sheets, re-open this window, and select Back side only before printing again. 9 Select an option from the "Binding" menu. The default option is Left, which prints the booklet like a book (folded on the left side) for left-to-right text.[9] If you want to fold the booklet on the long side of the page, select Left (Tall). If you're printing in a language that
reads right-to-left, select Right or Right (Tall) (if you want to fold the booklet on the long side of the page). 10 Set additional printing preferences (optional). Printers vary in capabilities, but you can typically click Properties next to the printer's name to choose additional settings, such as whether you want to conserve ink, print in color, or specify
printing margins. Some printers will automatically fold and staple your booklets if you choose the right settings. Check your printer's instruction manual. 11 Check the printing preview before you print. Use the arrow buttons below the print preview to page through the document. If you need to make any changes to the layout, make those changes
before you continue.[10] 12 Click Print to print your booklet. If you have an automatic-duplex printer, the pages will print on both sides of each sheet automatically. If you had to print the front-side only, re-insert the printed pages in accordance with your printer's instructions, return to File -> Print, select Booklet, and then chose Back side only from
the "Booklet subset" menu. 13 Fold your finished booklet. If your printer did not fold your booklet automatically, fold it along the desired spine (right or left). You can also staple the booklet to keep the pages intact. Advertisement 1 Open Microsoft Word. You can use Microsoft Word to print any multiple-page DOC or DOCX document as a booklet.
You'll usually find Word in a folder called Microsoft Office in the Start menu. 2 Open the document you want to print. Here's how:[11] Click the File menu at the top-left corner. Click Open. Navigate to the folder that contains the file you want to print. Select the document and click Open. 3 Click the PAGE LAYOUT tab. It's at the top of most versions
of Word.[12] 4 Click the icon at the bottom-right corner of the "Page Setup" panel. This panel is in the bar that runs along the top of Word. The icon is a tiny square with a diagonal arrow. Clicking this button will open the "Page Setup" dialog box.[13] 5 Select Book fold from the "Multiple pages" menu. It's under the "Pages" header near the center of
the dialog box.[14] This changes the orientation to landscape. 6 Adjust your margins and gutter size. These options are under the "Margins" header near the top of the dialog box. The default margins of 1" should work for most peoples' needs, but you may want to increase the "Gutter" value to a value higher than 1 cm (the default). This gives you
more space around the binded/folded part of the booklet.[15] 2 cm should be fine. 7 Click the Paper tab. It's at the top of the dialog box. 8 Choose the correct paper size for your printer. This is usually 8.5" x 11" (Letter) in the US, or A4 in Europe. If you're using a different paper size, select that size instead. 9 Click OK. This saves your document in a
format that will print like a booklet. 10 Click the File menu. It's at the top-left corner. 11 Click Print. This opens the Print dialog. 12 Select your printer from the "Printer" menu. Be sure to select a printer that supports printing on both sides of a single page (either automatic or manual duplex). 13 Select a Print on Both Sides option under "Settings."
The option you choose depends on your printer and your booklet.[16] If your printer automatically prints on both the front and back sides of a sheet without you having to flip the page manually (automatic duplex printing), select Print on Both Sides (Flip pages on long edge) to print in a standard book-like format, or Print on Both Sides (Flip pages on
short edge) to flip each page along the shorter side of the page. If you have to manually flip pages to print on both sides, select Manually Print on Both Sides. You'll need to manually reload the pages when prompted by your printer to print on the other side.[17] 14 Set additional printing preferences (optional). Printers vary in capabilities, but you can
typically click Printer Properties below the printer's name to choose additional settings, such as whether you want to conserve ink, print in color, or specify printing margins. Some printers will automatically fold and staple your booklets if you choose the right settings. Check your printer's instruction manual. 15 Check the printing preview before you
print. Use the arrow buttons below the print preview to page through the document. If you need to make any changes to the layout, make those changes before you continue. 16 Click Print to print your booklet. If you have an automatic-duplex printer, the pages will print on both sides of each sheet automatically. If not, follow the instructions on the
printer's panel to reinsert the pages. 17 Fold your finished booklet. If your printer did not fold your booklet automatically, fold it along the desired spine (right or left). You can also staple the booklet to keep the pages intact. Advertisement 1 Open Word. You can use Microsoft Word to print any multiple-page DOC or DOCX document as a booklet.
You'll usually find Word in a folder called Microsoft Office in the Applications folder. To print a booklet properly, you'll need a printer that is capable of printing on both sides of a single page. 2 Click the File menu. It's at the top-left corner of the screen. 3 Click New from Template. A list of templates will appear. 4 Type booklet into the search bar. The
search bar is at the top-right corner of the window. This filters the template results to show only booklet templates, which are already formatted to print in the correct booklet page sequence and orientation.[18] You'll be able to type or paste your own content into any booklet template. 5 Double-click the template you want to use. There are several to
choose from, and all are customizable. 6 Insert your own content into the booklet. The look of your booklet is up to you, but you'll typically want to replace most, if not all, of the text and logos from the template with your own content. To insert an image, click the Insert tab, select Pictures, and then Pictures from File. Select the photo you want to
import, then drag it to the desired location in the booklet. Remove any placeholder text on the template and replace it with your own. To remove any visual element or text from the booklet, select the item (or highlight the text), then press Del. Don't forget to save your work as you make changes. 7 Click File when you're ready to print. It's at the top-
left corner.[19] 8 Click Print. A preview of your booklet will appear, as will some settings you can modify. If you don't see the preview, select Copies & Pages from the third drop-down menu, then check the box next to "Show Quick Preview" at the bottom.[20] Use the arrows below the preview to see what each printed page will look like. 9 Select your
printer from the "Printer" menu. It's at the top of the window. 10 Enter the number of booklets you want to print. It's a good idea to start with 1 to make sure it looks the way you'd like. Type this value into the "Copies" field. If you print more than one booklet, check the box next to "Collate" so that the Word prints one booklet at a time (rather than
multiple copies of the first sheet, then the second sheet, etc.). 11 Select other options for your printer. Printers vary in capabilities, but you can typically use the menus at the top of the window to customize the print, such as whether you want to conserve ink, print in color, or specify margins.[21] 12 Click Print to print your booklet. If you have an
automatic-duplex printer, the pages will print on both sides of each sheet automatically. If not, follow the instructions on the printer's panel to reinsert the pages. 13 Fold your finished booklet. If your printer did not fold your booklet automatically, fold it along the desired spine (right or left). You can also staple the booklet to keep the pages intact.
Advertisement Ask a Question Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Nicole Levine, MFA. Nicole Levine is a Technology Writer and Editor for wikiHow. She has more than 20 years of experience creating technical documentation and leading support teams at major web hosting and
software companies. Nicole also holds an MFA in Creative Writing from Portland State University and teaches composition, fiction-writing, and zine-making at various institutions. This article has been viewed 202,996 times. Co-authors: 13 Updated: February 24, 2025 Views: 202,996 Categories: Making Books Print Send fan mail to authors Thanks to
all authors for creating a page that has been read 202,996 times. 1 Open Acrobat Reader DC on your PC or Mac. Adobe Acrobat Reader DC makes it easy to print multiple-page PDF files as booklets using Windows or macOS. If you're using Windows, you'll usually find it in the Start menu. If you're using a Mac, you'll usually find Acrobat Reader DC in
the Applications folder. 2 Open the booklet file. Here's how:[1] Click the File menu at the top-left corner of the screen. Click Open. Open the folder containing the file you want to print. Select the file and click Open. Advertisement 3 Click the File menu. It's at the top-left corner.[2] 4 Click Print. This opens Print dialog screen.[3] 5 Select your printer
from the "Printer" menu.[4] 6 Select which pages to print. To print the entire document, leave All selected under "Pages to Print." To specify a page range, select Pages, then enter the range. Here are some examples of ways you can enter pages to print:[5] To print pages 2 through 10, you'd enter 2-10 into the "Pages" blank. To print pages 1, 4, 9,
and 14, you'd type 1, 4, 9, 14 into the "Pages" blank. If you'd need to print multiple page ranges (e.g., 2 through 12 and 43 through 52), you should print each range separately.[6] 7 Click Booklet. It's under the "Page Sizing & Handling" header. A preview of the document in booklet format will appear on the right side of the panel.[7] 8 Select a duplex
option from the "Booklet subset" menu. The option you select depends on how your printer handles printing on both sides of the page:[8] If your printer automatically prints on both the front and back sides of a sheet without you having to flip the page manually (automatic duplex printing), select Both sides. If you have to manually flip pages to print
on both sides, select Front side only for now. After printing the pages that appear on the front side of each sheet, you'll flip the sheets, re-open this window, and select Back side only before printing again. 9 Select an option from the "Binding" menu. The default option is Left, which prints the booklet like a book (folded on the left side) for left-to-right
text.[9] If you want to fold the booklet on the long side of the page, select Left (Tall). If you're printing in a language that reads right-to-left, select Right or Right (Tall) (if you want to fold the booklet on the long side of the page). 10 Set additional printing preferences (optional). Printers vary in capabilities, but you can typically click Properties next to
the printer's name to choose additional settings, such as whether you want to conserve ink, print in color, or specify printing margins. Some printers will automatically fold and staple your booklets if you choose the right settings. Check your printer's instruction manual. 11 Check the printing preview before you print. Use the arrow buttons below the
print preview to page through the document. If you need to make any changes to the layout, make those changes before you continue.[10] 12 Click Print to print your booklet. If you have an automatic-duplex printer, the pages will print on both sides of each sheet automatically. If you had to print the front-side only, re-insert the printed pages in
accordance with your printer's instructions, return to File -> Print, select Booklet, and then chose Back side only from the "Booklet subset" menu. 13 Fold your finished booklet. If your printer did not fold your booklet automatically, fold it along the desired spine (right or left). You can also staple the booklet to keep the pages intact. Advertisement 1
Open Microsoft Word. You can use Microsoft Word to print any multiple-page DOC or DOCX document as a booklet. You'll usually find Word in a folder called Microsoft Office in the Start menu. 2 Open the document you want to print. Here's how:[11] Click the File menu at the top-left corner. Click Open. Navigate to the folder that contains the file
you want to print. Select the document and click Open. 3 Click the PAGE LAYOUT tab. It's at the top of most versions of Word.[12] 4 Click the icon at the bottom-right corner of the "Page Setup" panel. This panel is in the bar that runs along the top of Word. The icon is a tiny square with a diagonal arrow. Clicking this button will open the "Page Setup"
dialog box.[13] 5 Select Book fold from the "Multiple pages" menu. It's under the "Pages" header near the center of the dialog box.[14] This changes the orientation to landscape. 6 Adjust your margins and gutter size. These options are under the "Margins" header near the top of the dialog box. The default margins of 1" should work for most peoples'
needs, but you may want to increase the "Gutter" value to a value higher than 1 cm (the default). This gives you more space around the binded/folded part of the booklet.[15] 2 cm should be fine. 7 Click the Paper tab. It's at the top of the dialog box. 8 Choose the correct paper size for your printer. This is usually 8.5" x 11" (Letter) in the US, or A4 in
Europe. If you're using a different paper size, select that size instead. 9 Click OK. This saves your document in a format that will print like a booklet. 10 Click the File menu. It's at the top-left corner. 11 Click Print. This opens the Print dialog. 12 Select your printer from the "Printer" menu. Be sure to select a printer that supports printing on both sides
of a single page (either automatic or manual duplex). 13 Select a Print on Both Sides option under "Settings." The option you choose depends on your printer and your booklet.[16] If your printer automatically prints on both the front and back sides of a sheet without you having to flip the page manually (automatic duplex printing), select Print on Both
Sides (Flip pages on long edge) to print in a standard book-like format, or Print on Both Sides (Flip pages on short edge) to flip each page along the shorter side of the page. If you have to manually flip pages to print on both sides, select Manually Print on Both Sides. You'll need to manually reload the pages when prompted by your printer to print on
the other side.[17] 14 Set additional printing preferences (optional). Printers vary in capabilities, but you can typically click Printer Properties below the printer's name to choose additional settings, such as whether you want to conserve ink, print in color, or specify printing margins. Some printers will automatically fold and staple your booklets if you
choose the right settings. Check your printer's instruction manual. 15 Check the printing preview before you print. Use the arrow buttons below the print preview to page through the document. If you need to make any changes to the layout, make those changes before you continue. 16 Click Print to print your booklet. If you have an automatic-duplex
printer, the pages will print on both sides of each sheet automatically. If not, follow the instructions on the printer's panel to reinsert the pages. 17 Fold your finished booklet. If your printer did not fold your booklet automatically, fold it along the desired spine (right or left). You can also staple the booklet to keep the pages intact. Advertisement 1
Open Word. You can use Microsoft Word to print any multiple-page DOC or DOCX document as a booklet. You'll usually find Word in a folder called Microsoft Office in the Applications folder. To print a booklet properly, you'll need a printer that is capable of printing on both sides of a single page. 2 Click the File menu. It's at the top-left corner of the
screen. 3 Click New from Template. A list of templates will appear. 4 Type booklet into the search bar. The search bar is at the top-right corner of the window. This filters the template results to show only booklet templates, which are already formatted to print in the correct booklet page sequence and orientation.[18] You'll be able to type or paste
your own content into any booklet template. 5 Double-click the template you want to use. There are several to choose from, and all are customizable. 6 Insert your own content into the booklet. The look of your booklet is up to you, but you'll typically want to replace most, if not all, of the text and logos from the template with your own content. To
insert an image, click the Insert tab, select Pictures, and then Pictures from File. Select the photo you want to import, then drag it to the desired location in the booklet. Remove any placeholder text on the template and replace it with your own. To remove any visual element or text from the booklet, select the item (or highlight the text), then press
Del. Don't forget to save your work as you make changes. 7 Click File when you're ready to print. It's at the top-left corner.[19] 8 Click Print. A preview of your booklet will appear, as will some settings you can modify. If you don't see the preview, select Copies & Pages from the third drop-down menu, then check the box next to "Show Quick Preview"
at the bottom.[20] Use the arrows below the preview to see what each printed page will look like. 9 Select your printer from the "Printer" menu. It's at the top of the window. 10 Enter the number of booklets you want to print. It's a good idea to start with 1 to make sure it looks the way you'd like. Type this value into the "Copies" field. If you print
more than one booklet, check the box next to "Collate" so that the Word prints one booklet at a time (rather than multiple copies of the first sheet, then the second sheet, etc.). 11 Select other options for your printer. Printers vary in capabilities, but you can typically use the menus at the top of the window to customize the print, such as whether you
want to conserve ink, print in color, or specify margins.[21] 12 Click Print to print your booklet. If you have an automatic-duplex printer, the pages will print on both sides of each sheet automatically. If not, follow the instructions on the printer's panel to reinsert the pages. 13 Fold your finished booklet. If your printer did not fold your booklet
automatically, fold it along the desired spine (right or left). You can also staple the booklet to keep the pages intact. Advertisement Ask a Question Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Nicole Levine, MFA. Nicole Levine is a Technology Writer and Editor for wikiHow. She has
more than 20 years of experience creating technical documentation and leading support teams at major web hosting and software companies. Nicole also holds an MFA in Creative Writing from Portland State University and teaches composition, fiction-writing, and zine-making at various institutions. This article has been viewed 202,996 times. Co-
authors: 13 Updated: February 24, 2025 Views: 202,996 Categories: Making Books Print Send fan mail to authors Thanks to all authors for creating a page that has been read 202,996 times. One of the greatest features that PDF Printers offer is PDF booklet printing. The ability to print a book from PDF is one of the important tools that enables PDF
software to deliver on their worth. Book and booklet creation is a distinct tool available in only certain PDF Printers. Users should investigate a full list of features for specific software to see if this feature is included and supported. This guide gives you the best PDF Printer - Wondershare PDFelement - PDF Editor Wondershare PDFelement
Wondershare PDFelement to print booklet in PDF. G2 Rating: 4.5/5 |100% Secure How to Print a Book from PDF Files Printing a booklet in PDF using PDFelement is a simple process. It is highly integrated to provide a seamless and user friendly experience on every level. Creating and Printing a booklet in PDF using PDFelement is as simple as
printing normal PDFs. Each of the basic functions of the software only require a hand full of steps, enabling individuals to perform a variety of tasks from one simple platform. The drop down menu within the print platform contains each of the basic functional options to access the full range of features for the software. Step 1: Open the PDF with
Booklet Simply open the PDF you wish to print. You can either click the "Open File..." button, or click on the folder icon which is displayed as opening function on the top toolbar. Step 2: Go to the Print Options You should click the "File" button and click "Print" in the list. You will see all the available printing options there, like printer properties,
copies, pages etc. G2 Rating: 4.5/5 [100% Secure Step 3: Print Booklet in PDF After you click "Print", look for the "Print Mode" button. After clicking on this button you will see an option for "Booklet". After you locate the "Booklet" button, click it. You will see the option to choose additional options and parameters you would like to see displayed in
your booklet. After you are satisfied with your choices, click "Print" and your document will be generated and printed as a booklet. G2 Rating: 4.5/5 |100% Secure NOTE: individuals should understand the different between booklet creation and regular PDF creation. In the process of creating regular PDF, the same steps above are followed, accept
that individuals will simple choose "File" and "Print". This simple two-step process is why PDFelement is a desirable alternative to PDF printing across the board as it assists with easier and faster PDF creation as well as editing of any PDF that has been created or other PDFs within the user's possession. PDFelement is an excellent tool for personal,
professional, and industry needs. The software allows for seamless integration on Windows or Mac and works with standard setting speed that positions the software as a leader within available PDF software. For its level of speed, integration on multiple devices, ability to handle large amounts of conversions and larger projects, it is no doubt the best
PDF tool. PDFelement is one of the best PDF Printers available. Not all PDF Printers contain booklet creation capability and booklet printing capability. It utilizes a booklet creation tool that is as seamless and easy as producing normal PDF prints of individual pages. The product and output of PDFelement booklet creation read and feel exactly like an
online book or eBook that can be easily accessed across multiple readers, internet platforms, and market platforms. G2 Rating: 4.5/5 |100% Secure It offers a number of features including batch conversions, higher speed conversions, booklet creation, annotations, commenting, and conversations of multiple file types. This makes PDFelement one of
the top and best performing PDF Printers that is viable for a variety of personal and professional aims. Tips on Printing Booklet in PDF Individuals may wish to print PDF booklets in the case they want to create books for a variety of purposes. PDFelement offers conversion of documents to ePub, one of the industry standard digital printing formats.
From a PDF booklet, PDFelement makes it easy to make a document marketable. Other utilizations of this tool enable individuals to compile large amounts of data and information for their personal purposes, increasing organization and effectively communicating more comprehensive sets of thinking than can be communicated through individuals
PDF pages. Printing PDF files and printing PDF booklets is a similar process within the software, yet they are two distinct tasks. The tasks are different based on the composition of the document, whereas, PDF files are generally a few pages and a booklet consists of substantially more pages. The product of a printed booklet outputs in a form that
enables it to be read in book format without viewing multiple printed pages or without having to recompose these pages. It is easily and seamless integrated with external readers on the user’s computer as well as compatible with major internet based booklet printing software for mass marketing. Free Download or Buy PDFelement right now! Free
Download or Buy PDFelement right now! Try for Free right now! Try for Free right now! The booklet improves the reading experience and is easier to carry. If you have a PDF file for a particular purpose, you can print it in the booklet. This article will address how to print a PDF as a booklet in easy and quick ways. Continue reading for more details.
Do you want to print PDF as a booklet on Windows? Discover the tool UPDF and launch it on your PC to print PDF files as a booklet. It allows you to print the PDF file in the desired layout with features like changing the paper scaling, size, and orientation in its print menu. Moreover, you can select page ranges easily for printing with this tool.
Moreover, you can also customize the print content for the printing copy by selecting whether it includes forms, documents, and annotations. To print PDF in booklet format on Windows, download UPDF via the below button and install it on your computer. Then, follow the below steps. Windows * macOS ¢ iOS ¢ Android 100% secure Run UPDF on
your PC to open its home page. Upload your PDF file on this tool by clicking on the "Open File" button and going to the "File" tab. From there, select the "Print" option to open the print menu. You can also press "Ctrl + P" directly to open the print settings. On the "Print" window, select the printer and page size from the given options. Now go to "Print
Sizing && Handling" and select the option of "Booklet." From the "Booklet" settings, you can select "Booklet Subset." Here, it has three options: Both Sides, Front Side Only, and Back Side Only. Choose your preferred subset to print the booklet. If you need to, you can change the Binding directions - the left or right direction. In this part, UPDF also
allows you to choose to print PDF in color or in grayscale. Once done with the settings, navigate to the "Print" highlighted button and click on it to print your PDF file as a booklet. In addition to printing PDF in portrait mode, UPDF also enables you to print in landscape mode. Want to try it? Tap on the "Free Download" button to get it. Windows ¢
macOS ¢ iOS ¢ Android 100% secure If you want to learn more about printing PDFs as booklets on Windows with UPDF, please watch the video below, and hope it will help you. To print PDF as a booklet on Mac, UPDF is also a suitable choice. It offers various printing properties that enable users to take printouts in their desired style. To use UPDF
for Mac to print PDFs as Booklets, you can follow the steps below. Click the button below to download and launch UPDF. Then, click on the "Open File" button on the home page to upload the PDF you want to print as a booklet. Windows * macOS ¢ iOS * Android 100% secure After uploading the file, select the "File" tab displayed on top and select the
"Print" option. On the Print setting window, select your printer. Then, update the "Media & Quality" to "Layout", select 2 in the "Pages Per Sheet" tab, and choose "Booklet" in the "Two-Sided" part. You can also do other settings based on your needs. When everything is done, click on the "Print" button to finalize the process. We made a video to help
you learn how to print a PDF on Mac better. Watch it now. Windows ¢ macOS ¢ iOS ¢ Android 100% secure UPDF for Windows now supports the batch print feature. It will save money and improve your productivity vastly. Below are the steps to follow: After you open the UPDF application on Windows, you will see a "Batch" option on the welcome
page. Click on it. On the new page, choose "Print". Now you need to add as many PDF files as you want. In the right-sidebar, click the dropdown menu of "Page Sizing and Handling" and select "Booklet". You can also set the booklet subset and the binding. After you select the right printer, click the "Apply" button. All your PDF files will be printed
immediately. Easy, right? Download UPDF to try it now. Windows ¢ macOS ¢ iOS ¢ Android 100% secure A booklet works like a book by giving information and data on any particular topic. It contains fewer pages than an actual book and acts as a cost-effective alternative to the book. Many people like to print their PDF files in the form of a booklet so
that they can read the content in a comfortable way. It brings multiple benefits for the users, such as an easy reach to the audience without consuming too many pages. The booklet has various formats depending upon the need of a user. However, an average booklet contains 4 to 52 pages and functions as a small book. The letter-size paper of a
booklet is folded in half, which helps the user to read the content in the same way as we read in a book. The most common size of a landscape or portrait booklet is 5.5 in x 8.5 in. There are several uses of a booklet in many fields. Many brands like to create a booklet in the form of a catalog to display their best designs effectively. Some brands like to
promote their product through a booklet by crafting their designs and advantages and adding a user guide to it. People who are running small-scale businesses can create booklets to display their training programs in a captivating way. You can add instructions, key objectives, and guidelines in the booklet to precisely reach your audience. For
academic purposes, teachers can create the outlines and objectives of the courses in the form of a booklet so that students can access them easily. Before making a booklet, you need to have authentic knowledge about your target audience. Your goal should be to engage the audience without adding too much content to the booklet. List down the
factors, viewpoints, and other content that you want to add to the booklet. After deciding the precise content for your booklet, gather ideas for its design. Make sure that you present your booklet in the most captivating way through an alluring design. Add some color to it and list down all the required factors in an organized way. Also, preserve the
professional outlook of your booklet and keep the alignments correct. You can organize the PDF pages in a specified order for printing booklet from PDF if you do not have one tool like UPDF. Use the following pattern to arrange the PDF pages so that you can give them the shape of a booklet after printing. If you have 4 pages in a PDF file, arrange
them in this order: Page 4 and 1 on the first side of the first sheet Page 2 and 3 are on the second side of the first sheet. Similarly, if you have more pages, you can arrange them by following the above order. And to organize PDF pages, you still need one PDF editor. What's more, it is not easy to rearrange the pages in the desired order if your PDF
has many pages. So, we suggest you use UPDF to print PDF to booklet directly to save time. You can download UPDF via the below button. Windows ¢ macOS ¢ iOS ¢ Android 100% secure There is no way to print the Booklet in PDF on Mac using Preview. But you can use UPDF to do it easily. To print a booklet from a PDF on Microsoft Edge, you
need to save the PDF on your computer from Microsoft Edge. Then, Open it with UPDF, click "Print" and choose "Booklet" to print. To print PDF two pages per sheet with UPDF, go to the "Print" settings and locate the option "Booklet" from the "Page Sizing & Handling" section. Choose "Both Sides" in the Booklet Subset area and you will get two
pages per sheet on your print. You can see the effect in the print preview section. UPDF has the option to print two-sided pages in the printer settings. Locate this option and enable it to print a PDF side by side. Go to "File > Print > Booklet > Both Sides in Booklet Subset". It is easy to create a PDF booklet with a professional PDF solution called
UPDF. It has the option for you to create a blank PDF, edit everything on a PDF document, and organize pages in a PDF document. To make a PDF booklet, you can use it to add text, links, and images, and customize the PDF as per your requirements. You can also use it to print the PDF booklet. Actually, there are no online tools to help you print
PDFs as Booklets. You can try to use UPDF to help you do the same. UPDF has proven to be the perfect choice to make a PDF and print it as a booklet. This tool includes several options and properties that users can utilize to produce desired results. Through its "Organize" feature, you can arrange the PDF pages in any specified order and can select
the preferred page layout from settings. Moreover, you can conduct editing on the PDF files before printing them easily. Booklets bring unlimited benefits with them as they engage with the audience in a cost-effective manner. You can design your booklet in a PDF file and print it in the form of a booklet. This article has comprehensively touched on
how to print a PDF as a booklet through powerful tools and simple steps. Try UPDF now to enjoy the printing feature immediately. Windows ¢ macOS ¢ iOS ¢ Android 100% secure



